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MODELING EXERCISES
This chapter contains step by step instructions for creatingmodels for a variety of parts. Themodels
in this chapter will bemachined in theMachining Exercises so be sure to save them for later use.

#1: Phone
• Creating The Phone

• Modifying the Phone

Creating The Phone

Part Set-Up 

For the Part Print for this exercise, see “Part Prints” on page 163.

1. Create ametric 3 Axis Vertical Mill partwith the following workspace stock size:
+X= 120, -X= -120, +Y= 50, -Y= -50, +Z= 0, -Z= -75

2. Save this part as Phone.vnc for later use in themachining exercises.

Lofted Profile

1. Open theGeometry Creation

palette.

2. Create the geometry for segments A, B
and C.

Segment A
Two horizontal lines and two tangent arcs define the top shape. In order to create tangent arcs,
a point and line need to be created. Create the vertical lines and a point tangent to the lines at
Y0, then define the arcs tangent to the line and the point. Since the points appear at zer0 you
may find it quicker to use theMid-Point feature. Add the fillets after connecting the inner circles
to the horizontal lines. Alternately youmay define this shape easily in Geometry Expert, since
the center points of each circle can be determined by subtracting the tangent distance from the
radius. However, be careful to select the correct connection points using thismethod.

Segment B & C
Four arcs define the next two shapes. Similar to Segment A the tangent lineswill need to be
created first. Connect the appropriate geometry and add the fillets. These shapes are also well
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suited for Geometry Expert. UseModify > Force Depth to adjust the Z depth of segment B and C.

Wewill now create a solid from the geometry inWG1 using the Loft tool. For a smooth blend,
we will need to select asmany alignment points on each of the three shapes as possible.

3. Ctrl-click the sync points shown. Select each point in sequence and in the direction of the
loft, fromSegment A to B followed byC (As above).

Method 1 - Shape sequence starting with
segment A Method 2 - Shape to Shape

Alignment points are used to determine how the shapeswill be aligned and blended. Alignment
pointsmust be selected in the right order. Alignment points can be selected in two ways,
selecting alignment points from shape to shape or select a single shapes alignment points, in
order, followed by the next shape in the same order.

4. Open the Solid Modeling
palette.

5. Open the Create Solid palette.

6. Open the Loft dialog.

7. Click the Do It button.

The results of the loft will look like the images shown here.
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Top View Side View

8. Double-click the loft to place it in the Body Bag.

Extruded Profile

1. Open the CS list.

2. Create CS2 and label it XZ plane.

3. Open the CS
palette.

4. Click the XZ button.

5. Open theWorkgroup list and createWG2 for the XZ geometry.

6. Switch to the home view (Ctrl+H).
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7. Create the geometry for segment
D, in CS2 XZ plane.

(For the Part print for this
exercise, see Part Prints)

Segment D
This shape ismade up of twomain tangent arcs, two vertical lines and four angled lines.

Wewill now create an extrusion from the geometry. Extrusions are done along the depth axis of
the current coordinate system.

8. Select any part of the segment D geometry and switch to the isometric view (Ctrl+I).

9. Open the solid Extrude dialog and enter the depth
shown.

10. Click the Do It button.

Profile Intersection

Wewill intersect this extrusion with the loft in the Body Bag.

1. With the Body Bag open, press (Ctrl+A) to select all.
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Since there are only two solids selected we can now perform an intersection. The selected
geometry will be ignored when performing the function. Unlike other Booleans the order of
selection doesn’t matter with Intersection.

2. Click the Intersection button in the Solid Modeling palette. You will be left with the shape
shown below.

Extracting a Body

Now wewill create a core for themold using the History list.

1. Click the show geometry button in the floating taskbar to hide the geometry.

2. Double-click themodel to place it in the Body Bag.

3. Right-click themodel you just placed in the Body
Bag and choose Show History.

The History list will open with the Extrude and Loft
bodies that were used to create the intersection.

4. Double-click the atomic body Extrude2.

The extrusion will be brought back selected in the workspace.
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5. Place Extrude2 in the Body Bag.

If a History list is large, an easyway to find the correct body is to open the body
properties dialog and click each entry in the tree. A preview image will be shown of
each item.

Making the Base

1. Switch to CS1: XY plane. (Hover over the CS button,
then slidemouse down).

Wewill now create a cube based on the workspace stock size. it is important to be in CS1 XY
coordinate system so that the cube will be in the correct position.

2. Open the Cuboid dialog from the Create Solid palette.

3. Click the Stock Dim.
button.

The StockDimension button applies the workspace stock size from the Document control dialog
to the cuboid text fields.

The core size needs to be adjusted to perform a subtraction. If the solids were subtracted with
these values it would result in an invalid body because of the tangency in the loft at Z0.We also
need the result to be two separate bodies so we need to adjust the X values of the cube to
match the extrude. 1mmwill be enough to create the needed solid.

4. Adjust the X and Z values as shown

and press Enter or .
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5. Make sure Face and Edge selection are turned off and click the cube, then
(Ctrl+click) the extrusion in the Body Bag.

When performing subtraction operations, the order the bodies are selected in is important. The
second body selected is subtracted out from the first body selected.

6. Click the Subtraction button.

Only the bottom
portion of the new solid
is needed for themold
core. The body
created from the
subtraction is an
unconnected, multi-
lump body that can be
separated into two
pieces.

7. Click the subtracted body and click the Separate button.

8. Click the top portion as shown and click the

Trash button or press Delete.

A message will appear indicating that the history of the deleted
object will be lost if deleted. That portion of the body is unnecessary
for themodel, so deleting it is not a problem. ClickOK.

9. Select the two remaining solids and add them together.

10. Place this solid in the Body Bag.
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Modifying the Phone

Filleting Corners

Amodel review has found that the underside of the phone needs to have a 6mm fillet that wasn’t in
the original plan. Luckily there is an easyway to fix the part.

1. Click the show geometry button and the show solids button to hide the solids.

2. Switch to CS 2 XZ plane andWG2.

3. Add the 6mm fillets as shown.

4. Extrude a new solid with the fillets.

Solids will become un-hidden when creating or modifying them.

With the edges still active you can now see the fillets clearly. Because the revision is small
however, it is a good idea to rename this body so it is easy to distinguish it from the other
extrude.
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Renaming a Body with the Properties Dialog

1. Right-click the new extrusion and choose Show Properties from the context menu.

2. Rename this solid Update fillets and place it in the Body
Bag.

Replacing a Body in the History

1. Open the History of themainmodel.

2. Double-click Extrude2 to extract it from the History of themainmodel.

3. Select the Update fillets solid and (Ctrl+click) the Extrude2 solid.
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4. Click the Replace button and Delete Extrude2.

Rebuilding the Model

1. Click themainmodel to see the Update fillets solid is in the History list
where the Extrude2 solid was.

The entry is disabled because it hasn’t been incorporated with the rest
of themodel.

2. Right-click themainmodel and choose Rebuild.

The new model is rebuilt using the Update Fillets body. The part is now complete.

3. Load themodel into themain workspace.

4. Save the part as wewill use it in amachining exercise.

#2: Hot Punch
For the part print for this exercise, see “Hot Punch” on page 164.

Part Setup

This exercise is designed to teach youmore about lofting, specifically the importance of selecting
the appropriate alignment points to create the desired body.

1. Create ametric 3 Axis Vertical Mill part with the following workspace stock size:
+X = 38, -X = -38, +Y = 50, -Y = -50, +Z = 0, -Z = -40
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Extruded Profile

1. Create the extrude geometry in the XY
plane.

2. Extrude this geometry and place it in the Body Bag.

3 Profile Loft

1. Create a YZ axis CS2 andWorkgroup #2.
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2. Create segments A and C.

Create one segment at a depth of

zer0 and thenModify >
Duplicate Dup + Force Depth/... to
make a copy at X= -38 and use

Modify > Transform> Force
Depth... to move the first segment
to X= 38.

3. CreateWorkgroup #3 for segment B
and create the geometry.

Moving Geometry to a Workgroup

1. Double-click anywhere on the geometry and press (Ctrl+X) (Edit > Cut).

2. Switch toWG2 and click (Ctrl+V) (Edit >
Paste).
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Now wewill loft these three shapes into a solid. In order to create the desired solid, we will need to
select the alignment points we want the system to use to blend the body. In order to achieve the
desired body, we want to align the two outside connectors of segment B with the top connectors on
segments A and C.

Selecting Alignment Points

1. Ctrl-click the
alignment points
shown.

2. Loft the geometry.

3. Select the loft and the extrusion.



Modeling Exercises

16

4. Create an Intersection from the two
solids.

5. Save the part for themachining exercises.

#3: Teapot
The 2D geometry for this part will be imported from an IGES file. The file can be found in either the
Sample parts folder or the installation CD. This file may be found on the
Sample Parts/Solids/Tutorial Parts - Required/Solid Surfacer folder in the application directory. (default is
Program Files)

Opening an IGES File Directly

1. Click (Ctrl+O) (Open) and change the
Files of type list to IGES (*.igs) files.

2. Open the Tea Pot.igs file.
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Auto-Size the Workspace

There is a stray point in the top corner.

1. Switch toWG3 and Delete the
point.

2. SelectModify > Shrink Wrap (Ctrl+')
and then (Ctrl+H) to show the Home
view.

This will adjust the workspace stock to fit the existing geometry.

Creating the Teapot

Revolving the Main Body

1. Click the CSmarker at the origin (CS2) and switch to the home view (Ctrl+H).
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2. Switch toWG2 and hide the other workgroups.

3. Click anywhere on the geometry and revolve it as
shown below.

4. Right-click on the body to open the Show Properties dialog and rename it Body.

Wewill now create a slicing plane tomake a base for themodel.

5. Create a new CS based on the current XZ and

open the Change CS Origin dialog in the CS

palette.

This will move the CS to the base of the stock.

6. Click the Body then slice and Delete
the small slice. (ClickOK to lose history and
Continue).
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7. Place the remaining solid in the Body Bag and rename it Main
Body by clicking the name as shown.

Each operation will change the name of the current state of a solid.

8. Switch toWG3 and loft the two circles shown.

9. Name this body Top.

Sweeping the Handle

Switch to CS1 and open the Sweep Solid dialog.

1. Select the circle shown and place the base curve pointer on the geometry.
Click the Do It button.
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2. Name this body Handle 1.

Two Drive Curve Sweep

Wewill use the same settings for the next sweep.

1. Select the two circles and place the pointer on the spline.
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2. Apply the sweep.

3. Name this body Spout.

Combining the Solids

1. In the body bag, select theMain Body and then the Top. Add

them together.

2. Click theMain Body+Top and add the Spout.

3. Select the Handle 1 and subtract Main Body+Spout.

4. Place themodified handle in the Body Bag and rename it Final Handle.

In order to get theMain body+Spout backwe need to extract it fromHistory.
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5. Right-click Final Handle and choose Show History.

6. Double-click theMain Body+Top+Spout Union lump.
This will extract the body selected and place it in the workspace.

7. Change theMain Body+Top+Spout name to Main Body.

Creating a Variable Radius Blend

Our next step will be to round the edge where the topmeets themain body.Wewill use the Variable
Radius Rounding that allows different radii to be applied at different locations along an edge.

1. Turn on Edge Selection and select the
edge shown.

2. Open the Advanced Solid Modeling palette and open the Blending dialog.

3. Select the Variable Radius blend.
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4. Adjust the view using the trackball as shown below. Place a radius pointer as shown (1)
and enter a 6mm Radius then place the second pointer.

Radius pointers get their radius information when
the pointer is red. To verify the radius setting for
each position, select the pointer.

5. Place the third pointer and change the Radius to 1mm, then place the last pointer shown.

6. Click the Do It button to apply the variable radius blend.
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Wewill now hollow out the solid.

Creating the Shell

1. Turn off Edge Selection and select the solid.

2. Turn on Face Selection

and (Ctrl+Click)
the two openings as
shown.

When using shelling, any deselected faceswill create entry holes in the shelled solid. A shelling
operation can create an offset outward or inward by using positive or negative values.

3. Open the Advanced Solid Modeling dialog, select Shell and
enter the value shown.

For this shelling operation wewant to create the offset inward to get the cavity.

4. Click the Do It button.
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5. Place the shell into the Body bag and rename
it Shell. Place Shell back into the workspace.

Unstitching the Cavity

1. Click the Edge Selection button.

2. Double-click the inside edge of the top
opening and (Ctrl+Double-click) the
inside edge of the spout as shown.

3. Click the Unstitch Solid button.

This will create two new solids, the
cavity and a filled body. The shell is
now only in the history. We don’t need
the outer solid that was created.

Measuring the Teapot Volume

1. Turn off Face Selection and Edge Selection.
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Deleting a Body

1. Delete the outer solid.

You have selected the correct
body if the outer solid is yellow
while the top and tip of the spout
are dappled gray and yellow. This
dappling effect signifies that two
surfaces are shared and one is
selected.

You will be asked if you wish to continue, that
history will be lost.

2. ClickOK or press Enter.

3. Double-click the core to place it in the Body Bag. Rename it Cavity.

Extracting the Shell from the History

In order to get the shell back, it needs to be extracted
fromHistory.
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1. Show History for the cavity and extract the shell.

2. Double-click the Shell to place it in the Body Bag.

3. Double-click Cavity to move it from the Body Bag to the workspace.

Now wewill slice the core using a surface created from the XZ plane. Once we have done that
we will calculate the volume of the teapot.

4. Switch to CS2 and open
the Surface Modeling

palette.

5. Click the Plane button.

This will create a planar sheet based on
the CS.

Slicing with a Plane

1. Select the plane and open theModify>Transform> Translate dialog.

2. Enter the values shown and click the Do It button.
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This will move the plane to approximately where the topmeets themain body.

3. While holding down the Ctrl key,
select the cavity and the plane.

A body can be sliced with either a sheet or the current coordinate system. If no sheet is selected,
it will slice with the CS.

4. Click the Slice button, press
Delete and Enter.

This will slice the solid into three pieces, Delete the small slices and accept the lost history
warning.

5. Switch to the top view (Ctrl+E).

6. Open the Properties for the remaining slice.

The Properties dialog can be used to name a part, identify it as a fixture, stock or part, modify the
chord height of the graphic or calculate Physical Properties.
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7. Rename andmove the Accuracy scale to
100%.

Calculating the Volume

1. Click the Calculate button on the properties dialog.

Even low accuracy
calculations can be quite
close.

2. Save this file as Teapot.vnc

#4: Plumbing
For the part print for this exercise, see “Plumbing” on page 165.

Creating the Plumbing

Part Setup

1. Create aMetric 3 Axis Vertical Mill part with the following workspace stock size:
+X = 60, -X = -80, +Y = 50, -Y = -90, +Z = 0, -Z = -50
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2. Create the geometry shown.

3. Extrude the rectangle.

Next, we will revolve the horizontal geometry about Y -50.

4. Open the Revolve dialog and revolve the horizontal geometry.

5. Revolve the vertical geometry.
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Mirroring

1. Select the first revolve and the extrusion and chooseModify >Duplicate> Duplicate + Mirror
and enter the Values ToMirror.

Wewill now create an angled shape.

2. Create aWG2 and CS2 .

3. Hide the solids.

4. Switch to the front (Ctrl+F).

5. Create a new XZ CS.

Aligning a CS

1. Create an angled line and point as defined in the print.
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The example shown is based on creating an angled line first, then creating a point on that angle
the specified distance. It could also be done the opposite way by creating the point and then
creating an angled line through that point. In the latter case wewouldn’t have needed to define
the point for each feature aswas needed for the example.

2. Open the CS palette and CS list.

3. Select the point and line.

4. Set the CS
preferences.

5. Right-click the align CS button.
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6. Choose Align Plane Through& Move (Alt).

7. Deselect the geometry and switch to the
home view (Ctrl+H).

If the home view does not look like the image press the Toggle Depth button and switch to the
home view (Ctrl+H) again.

8. Create a 14mmdiameter circle around the point.

Extruding the Slants

1. Extrude the circle.

Notice the solids become visible.

2. Switch to CS 1.
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3. Switch to the opposite isometric
view (Ctrl+Alt+I).

4. Click the extrusion and Duplicate + Mirror the extrusion using the same values from
earlier.

Wewill now add the bodies to create the final part.

5. Add all the solids together.



Modeling Exercises

35

Our next step will be to add a
radius to selected edges.We
will be selecting edges that
whenmachined, would not
otherwise be rounded by a
ball endmill, effectively
giving that edge a radius.

6. Hide geometry, stock and origin, and the CS grid.

7. Turn on edge selection.

Adding Intersection Blends

1. While holding down the Ctrl key select the
intersecting edges shown.

2. Blend the selected edges.
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3. Create a circle and extrude it to
the base of the stock (-Z = -50).

4. Switch to the isometric view (Ctrl+I) and turn off edge selection.

5. Subtract themodel from the extrusion.

Correcting A Design Flaw

The revolved cross pipe is too long. Instead of manually rebuilding the entire model we will use
Recreate and Rebuild to change entire Mold Cavity.

1. Hide solids and show the geometry, and the CS grid.

2. Create the revision geometry or edit the original.

An easyway to edit the original geometry would be to select the top part of the geometry, Modify
> Translate and reconnect it.
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Recreating the Cross Pipe

1. Show solids and open the History list.

2. Right-click the revolve and choose Recreate.

The solid will be sent to the Body Bag and will be colored red. The action to create the solid is
accessed and opened. The path to a dialog is highlighted in red on each palette. The Do It button
changes to a Redo button. At this point the revolve data could be edited but we don’t require
changes.

3. Select the revision geometry and press the Redo button.

If you created new geometry in a new workgroup youmust switch to thatWorkgroup.

Rebuilding the Model

If you have selected the wrong solid or do not wish to perform a recreate youmay get
out of Recreatemode by clicking on the red solid or by right-clicking a body and
choosing Exit Recreate.

1. Right-click themainmodel and

choose Rebuild.
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The rebuild is complete. All solids created that contain the recreated body are affected.

We can now see that the cross pipe is the correct size.

2. Save this part to be used later in themachining exercises.

#5: Remote Control
In this exercise wewill import a model. Wewill be importing a Parasolids file included on
theGibbsCAMCD. The file extension (.ext) of a Parasolid file can be different depending on the
design software. This file’s name is remote.x_t. To ensure we can find and open the file we will need
to check the system preferences.

Creating the Remote Mold

1. Press (Ctrl+O) (Open) and change the Files of type list to Parasolid (*.x_t; *.xmt) files.

2. Open the remote.x_t file.
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Re-positioning the Model

Weneed to rotate themodel to the XY CS.

1. Create a YZ CS.
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2. Select andModify > 2D Rotate themodel as shown.

3. SelectModify>Stock> Shrink Wrap (Ctrl+‘).

Our next step will be to apply a draft angle to the walls. Wewill need to select the faces this will
be applied to, as well as the reference edge to act as a pivot point.

Applying the Draft Angle

1. Turn on face selection and edge selection and switch to CS 1 XY, isometric view
(Ctrl+I).

2. Open the Advanced Solid Modeling palette.

3. Right-click the face shown and choose Select >SelectWall Faces.
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4. Zoom in and (Ctrl+Double-click) the outer edge above the selected face.

5. Draft the wall with the value shown.

A close inspection of the bodywill show that the sidewalls are no longer normal to the XY plane.

Creating Shutoffs

1. Turn off edge selection and pan (Ctrl+ ) left until the large opening is in view.

2. Right-click the blend of the largest circle and

choose Select> SelectWall Faces.

3. Click the Unstitch Solid button.

This will create two new solids, themodel with the large hole filled in and the hole.

4. Pan (Ctrl+drag) to the next set of holes.

Wewill now make a compound selection to unstitch the next two holes.

5. Right-click the blend of one of the next two holes and choose Select> Select Fillets.
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6. (Ctrl+Right-click) the selected fillets and choose Select> SelectWall Faces.

This will add the adjacent walls to the current selection.

7. (Ctrl+Right-click) the blend of the other hole and choose Select> Select Fillets.

8. (Ctrl+Right-click) the selection and choose Select> SelectWall Faces.

We now have all the fillets and walls of the two larger holes selected.

9. Click the Unstitch Solid button .

For the next four holes wewill use a similar technique but use select tangent faces rather than
fillets.

10. Switch to the home view (Ctrl+H).

11. Right-click the chamfer face of the first hole and

choose Select> Select Tangent Faces.

12. (Ctrl+Right-click) the chamfer and choose Select> SelectWall Faces.

13. Continue to add (Ctrl+click) the tangent faces and wall faces for the other three holes.

Once all the hole walls and chamfers are selected we can now unstitch them.

14. Click the Unstitch Solid button

.
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For the last hole wewill select the edge loops to unstitch.

15. Turn off face selection and turn on edge selection.

16. Zoom into the last hole and rotate (Shift+ + ) the view slightly.

17. Select the outer and inner edges of the remaining
hole. (Youmay need to rotate the part to see the
other side.)

18. Click the Unstitch Solid button.

19. Place themain body in the Body Bag.

Combining the Shutoffs

1. Add the holes together and place them in the Body Bag
and rename this body Shutoffs.

2. Un-Bag themainmodel.

3. Switch to the opposite isometric view (Ctrl+Alt+I).
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Creating the Core

1. Zoom in and Double-click the inside edge.

2. Click the Unstitch Solid button.

3. Place the outer solid in the Body Bag and name it Cavity.

4. Show properties of the inner solid and change the name to Core.

In order to create the base for our mold with a proper parting line, we will extract geometry from
a slice of the Core.

5. Create an XZ CS.

Extracting a Parting Line

1. Select the Core, then Slice

with the XZ CS and
Delete the selected front half.
(ClickOK to accept losing
history and continue.)
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2. Open the Document control dialog and increase the workspace stock size to:
+X = 90, -X = -80, +Y = 40, -Y = -40, +Z = 3, -Z = -30.

3. Switch to the unzoomed (Ctrl+U) isometric
view (Ctrl+I).

4. Double-click the bottom edge of the slice.

5. Switch to the home view (Ctrl+H).

6. Open theGeometry FromSolids palette within the Geometry palette.

7. Extract the geometry from the edge.

8. Turn off edge selection.

9. Place the sliced Core in the Body Bag.

Creating the Base with the Parting Line

1. In the XZ plane create lines parallel to the
axis at Z= -30, X= -80 and X= 90.

2. Delete the two terminator points.
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3. Connect the lines.

4. Extrude the geometry and name it Base.

5. Switch to the isometric view (Ctrl+I).

6. Open the history of the sliced Core in the Body Bag and
extract the Core body.

7. Non-destructively add (Alt+ ) the
two solids and rename the union Final
Core.

Wewill use the extrusion again tomake the top part of themold.
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8. Delete the Core and the sliced Core in the Body Bag.

Wewill no longer need these solids.

9. Switch to the XY CS.

Creating the Cavity

1. Create a Cuboid using the stock
dimensions.

Boolean Operations

1. Subtract the Base from the Cube and name the result
Cap.

2. Switch to the opposite isometric view (Ctrl+Alt+I) and

subtract the Cavity from the Cap and name it Prelim
Cavity.

3. Add the Shutoffs to the Prelim Cavity and rename it Final
Cavity.

4. Save the part here, to be used in themachining section of thismanual.
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This is the end product of the exercise, but lets verify themodel. Wewill combine the two halves
of themold and subtract a cube to see if our mold will create amodel.

5. Switch to the isometric view (Ctrl+I).

6. Perform a non-destructive addition (Alt+) of the Final Core and Final Cavity.

Remember, non-destructive Booleans are accomplished by holding down the Alt keywhen the
Boolean operation is performed.

7. Create another Cuboid using the workspace stock size.

8. Subtract the union from the new cube.
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MACHINING EXERCISES
The part models for all of the exerciseswere created in themodeling exercises of thismanual. If you
have not gone through those exercises and created the solid models for these parts, you should do
that now.We assume you are familiar with the interface and the principles used inMill and
Advanced CS.

All parts in these exercises are assumed to bemade of cast aluminum alloys. The feeds and speeds
are all defaults, based on the CutDATA™ values. The exercises do not provide a step for setting the
material but if you have CutDATA, please set the part material when you open the part file. If you do
not have CutDATA simply use the default material — stainless steel. The feeds and speedsmay be
set by clicking on the calculation buttons.

#1: The Phone
• The Set Up

• Creating Operations

The Set Up

In this exercise, we will use a roughing process to
remove the bulk of the stock. Lace cut surfacing
toolpathswill then be created to semi-finish the phone
core. Then wewill create finishing passes using the 2
Curve Flow and Surface Flow options.Wewill complete
themachining with an Intersection toolpath.

1. Open the Phone part created inmodeling exercises.

2. Make the following changes in the Document
Control DialogMachining Preferences tab.

3. Increase the original stock+Z to 3mmand add a Clearance value of 15mm.

4. Create the following tool list.
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# Type Total Length Diameter Bottom
Radius

#
Flutes Flute Length Material

1 Rough EM 121mm 25mm 0 3 45mm HSS
2 Ball EM 74mm 12mm n/a 4 25mm TiN Coated
3 Ball EM 73mm 9mm n/a 4 22mm TiN Coated
4 Ball EM 50mm 6mm n/a 4 19mm TiN Coated
5 Finish EM 50mm 6mm 1mm 4 19mm TiN Coated

Creating Operations

#1: Roughing

First, we will create a roughing process to remove the bulk of material from our starting stock.

1. Create this Roughing processwith the
25mmRough EM (Tool #1).

The Depth First option is not used in this
process.While the part may appear to
createmultiple pockets, themodel is really
an open sided pocket with a boss in the
middle. The roughing process is designed
to generate routineswhich will remove
material fromwithin a closed shape. You
may select only a body for the cut shape;
the toolpath generated will use the stock as
a constraint shape for the roughing. The
roughing toolpath will cut within the stock
shape, around the selected body.
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2. Enter this information in the Solids tab.

Select the Rough tolerance to generate
faster toolpath. Using the Slice Offset Body
option will generate 2D optimized toolpath.
Wewill use the default settings in theOpen
Sides tab.

3. Select themodel and click the Do it
button.

4. Render (F6) the cuts of the operation
to verify the results.
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Rendering after each operation is highly
recommendedwhenmachining solids.

Since this is an open pocket, the tool enters
from the outside of the part and cuts
towards the center.

5. Deselect the operation in the Op list.

6. Click in an empty space in the Process list and choose Select All (Ctrl+A) and press Delete.

This deletes all processes in the list.

#2-5: Lace Cuts

In order to create the semi-finishing lace cut toolpaths, we will slice the body into four quadrants.
This will allow us tomachine the part in sections; each section using a different cut angle and cutting
towards the top of the part in a clockwise direction.

1. Non-destructively (Alt) slice the
model with the XZ and a new YZ plane.

When sliced, you should have four pieces in addition to the original phone body.Wewill now
lace cut each section with the same processwith a different Cut Angle, starting with the piece in
the –X, –Y quadrant and continue clockwise around themodel.
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2. Create this Surfacing processwith the
12mmBall EM (Tool #2).

We are going to need to select only the faceswe intend tomachine. If we do not deselect certain
faces the toolpath will automatically cut over the edge of the body.While this does not violate the
solid quarter, it does cut into the final part.

The information in the Toolpath tab is of no concern to us right now. The format you would select
depends on the capabilities of your control.

3. Enter this information in theOptions
tab.

4. Switch to the XY plane.

5. Turn on Face Selection.

6. Right-click the face shown and choose Select>Select Faces Above.
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This will select only the faceswe need tomachine. The walls and bottom face will not be
selected because the faces are selected based on the current CS.

7. Create the toolpath.

The next quarter will only use a different Cut Angle.

8. Deselect the Operation in the op list.

9. Select the faces on the next quarter as we did for the last operation.
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10. Using the same process change the Cut Angle and create the toolpath.

The information contained in theOptions window remains the same on the following two lace cut
operations.

11. Deselect the operation.

12. Select the faces for the next quarter, change the Cut Angle and create the toolpath.
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13. Deselect the operation.

14. Select the faces for the last quarter, change the Cut Angle and create the toolpath.

We have specified that all tool cuts go toward the center of the part.

15. Render the operations.
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#6: 2 Curve Flow

The next operation to be performedwill be a 2 Curve Flow around the handset. For the tool to be
able to perform the operation wewill need to offset the handset geometry. Geometry acts as a
constraint area in 2 Curve Flow operations. If we did not offset the geometry the tool would have
very little room tomove, resulting in cutting only a few millimeters down from the top of the handset.

1. In the XY plane, select the base
geometry.

2. Open the Shape Offset (  > > ) dialog and create the offset shown.

1. Original
Shape

2. Outer
Offset
Shape

Shape Offset creates offsets in two directions from the original shape.

3. Delete the smaller interior offset that was created.
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4. Create this Surfacing processwith the
9mmBall EM (Tool #3).

Be sure to set the Cut Direction to Cut Across Curves. Cut Along Curves will follow the contour of the
shapes.Wewant to cut up and down around the handset.

5. Turn off Face Selection.

It is clear from the top view whywe
created the offset. The offset of 9mm
gives the tool room to perform the 2 Curve
Flow operation to the base of the phone.

To create the 2 Curve Flow operation wewill need to select alignment points in the geometry
similar to lofting a solid. Then, we will need to select the body.

6. Select alignment points in the order shown.
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The pointsmay be selected using the shape sequencemethod or the shape to shapemethod
described in themodeling exercise for this part.

7. (Ctrl+click) the body and create the
toolpath.

8. Render the part.

#7: Surface Flow

The next operation will machine the top of the handset.
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1. Create this Surfacing processwith 6mm
Ball EM (Tool #4). Set the Options tab
items as shown.

2. Turn on Face Selection and select the
top face.

This operation will produce toolpath that cuts back and forth along the Y axis, producing a
smooth finish on the handset.

3. Create the toolpath.

4. Render the part.
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#8: Edge Intersection

Finally, we will create an Intersection cut using a selected edge. This will serve to clean up the
bodywhere larger tools could not reach.

1. Create this Surfacing processwith the
6mmFinish EM (Tool #5).

2. Turn on Edge Selection and Double-
click anywhere on the edge shown.
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Make sure you are using the 3D chainmode in the edge context menu. For more information,
see "Edge Context Menu" chapter in Solid Surfacer User guide.

3. (Ctrl+click) anywhere on the body and create the toolpath.

4. Render the part.

#2: The Hot Punch
TheHot Punch will bemachined with three operations — a contouring operation to clear the
perimeter of the part, followed by a lace cut surfacing operation to finish the part, followed by a
projected engraving operation.

Part Set-up

Document Control Dialog

1. Open the Hot Punch part created inModeling Exercise #2.

2. Change the workspace stock size to the following dimensions:
+X = 40, -X = -40, +Y = 35, -Y = -35, +Z = 0, -Z = -45

3. Add a Clearance value of 15mm.

4. Set the Global Settings in theMachining Preferences
tab as shown.

Tool List

1. Create the following tool list.

# Type Total
Length Diameter Corner/Tip #

Flutes
Flute
Length Material

1 Rough EM 121mm 25mm 0mm 3 45mm HSS
2 Ball EM 73mm 10mm n/a 4 22mm TiN Coated
3 3.15 Center Drill 31.5mm 3.15mm 118 2 1.9mm Carbide Solid

*For the Center Drill you will only need to specify the Size from themenu.
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Creating Operations

#1: Contouring

First, we will create an operation to contour around the part, creating a single pass along the
outside wall.

1. Create this Contour process using the
25mmRough EM (Tool #1).

2. Enter this information in the Solids tab.

The settings in theOpen Sides tab do not influence this operation so we can ignore it.

To define the cut shape for this process, we will use only the Profiler, no solids or sheets. The
systemwill only use the profile shape andmachiningmarkers to create the toolpath.

3. Click the Toggle Profiler button.

4. Drag the grid to where the entire outer perimeter is
selected. (if necessary check in Side view)

5. Select the profile.
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6. Set themachiningmarkers as shown.

Themarkers should be set for conventional cutting.

Make sure the solid is not selected. If the solid is selected, the systemwill attempt to project the
contouring toolpath onto the selected body. The result would be the same toolpath, however it
takesmuch longer to process.

7. Create the toolpath.

#2: Lace Cut

The next operation will lace cut across the top face of the part.

1. Create this Surfacing processwith the
10mmBall EM (Tool #2).

2. Enter this information in theOptions tab.

The Z Surfaces Offset Rough Lace Cut option is very useful with custom stock bodies, particularly
those that have undulating shapes. The Constant # of passes option uses the desired Z Step value
to break up the range of the cut into sections. Each of these sectionswill be completely cut by
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the pass, there are no retract moves. Each passwill be a different shape which cuts over the
entire selected body.

The Clear Stock option is not selected because we do not want the surfacing toolpath to cut the
area of the part that has been removed by the previous contouring operation.When Clear Stock
is off, the toolpath generated by the processwill only look at the selected part model rather than
the stock, whether it be a stock body or the stock definition entered in the Document Control
dialog. By turning Stay In Stock on wewill confine the generated toolpath to the stock boundaries.
Were this option off, the toolpath would have two additional passes outside of the stock bounds
to complete the body’s shape. This is not necessary in this part.

3. Select the solid and create the toolpath.

Isometric View Right Side View

#3: Engraving

Finally, we will create text and engrave the top face of the part. The Contouring process provides for
centerlinemachining of all selected shapeswhich include text and artwork. Contouring operation
toolpaths can be projected on to sheets and bodies.

Wewill need to create text geometry that can bemachined. The system can create spline
geometry from any TrueType font. Youmay need to set the directory that contains the fonts for
your system. There is a Font Directory item in the Preferences > File tab which allows you to
designate a directory that contains your system fonts. TheMoorpark TrueType font used in this
exercise is shipped with each order.

1. Open the Text Creation dialog.

2. In the Text Flow tab select the clockwise arc button for the Shape.

3. Enter the above information in the Text tab.
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4. Create the text. If your text looks too
unclear, make sure you have View>Draw
points (Ctrl+J) unchecked. This turns off
display of points connectors and
terminators.

If you have any problemswith text creation,
refer to the Text Creation Exercise in the
Geometry CreationManual.

5. Select the text geometry. (Shift+drag) to draw awindow and select an area, then
(Ctrl+click) to deselect the solid.

6. Create this Contouring processwith the
Center Drill (Tool #3).

Whenmore than one shape is selected prior to creating a contouring process, the system
automatically assumes that you are doing engraving. Several itemswill become disabled. The Z
Stock option is used in this case so that the engraving toolpath will cut into the selected body.
The toolpath generated by the operation will be shifted down along the Z axis only by the
amount specified. The toolpath itself will be projected onto the surface of the body and then will
be shifted down in Z to cut into the body.
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7. Enter this information in the Solids tab.

8. (Ctrl+click) the solid.

Make sure the text geometry is still selected.

The text and the body should both be selected.When 2D geometry and a solid or sheet are
selected for the cut shape of a process, the toolpath will be a projection of the 2D toolpath onto
the body or sheet.

9. Create the toolpath.

10. Render the operations.
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11. Save this part.

#3: Plumbing
• Part Set-Up

• Machining The Part

Part Set-Up

The Basics

Tomachine thismold wewill first use a roughing process to clear out the greatest amount of
material. Wewill then use a series of lace cutting operations tomachine specific areas of the part.
Next, we will use a contour operation to cut a particular face. Lastly we will select certain faces for
an intersection.

1. Open the Plumbing part created in Exercise #1 in the Solid Modeling Exercises.

2. Ensure the workspace stock size is:

+X = 80, -X = -80, +Y = 80, -Y = -80, +Z = 0, -Z = -50.

3. Add a Clearance value of 15mm.

4. Set the Global Settings in theMachining Preferences
tab as shown.

5. Create the following tool list.

# Type Total Length Diameter Corner/Tip # Flutes Flute Length Material

1 Rough EM 73mm 10mm 2mm 2 22mm HSS
2 Ball EM 50mm 6mm n/a 4 19mm TiN Coated
3 Finish EM 100mm 25mm 0mm 4 38mm TiN Coated
4 Ball EM 38mm 3mm n/a 4 20mm TiN Coated

Stock Body

The first thing wewill do is designate a stock body.Wewill use the extruded cylinder as a basis
for this.
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1. From Show History list extract the extruded cylinder.

Wewill need tomodify this solid so it will work as a stock body. A stock bodymust be larger than
the part to bemachined on all sides. The general formula for how much larger the stockmust be
is: surface stock + surface tolerance. This is a general rule. In this case wewill just offset the
stock body larger by 1mm.

2. Select the extrude.

3. Offset the cylinder by the amount shown.

4. Right-click the offset cylinder and choose Properties.

5. Designate the body as Stock.

The stock body now extends 1mmoutside the workspace stock. This will not affect the
machining.
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Machining The Part

#1-3: Roughing

1. Create this Roughing processwith the
10mmRough Endmill (Tool #1).

2. Set theMinimum cut to 5mm in theOpen Sides tab.

3. Enter this information in the Solids tab.
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4. Select the solid and create the toolpath.

5. Render the operations.

#4: Lace Cut

For this operation wewill select all of the faces that make up one of the twomain cavities.

1. Turn on Face Selection and
(Ctrl+click) the faces shown.
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2. Create this surfacing processwith the 6mm
Ball EM (Tool #2).

Note that the Fixed option has been selected for the CutWidth. The Ridge Height value of
0.004mmwas entered and the XY Stepover was calculated at 0.31mm.

3. Enter this information in theOptions
tab.

This process is going to be used as a semi-finishing operation to clean up or even out areas of
the part that still have a lot of material after the roughing operation.

4. Create the toolpath.
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#5: Lace Cut

1. Deselect the operations and faces.

For the next operation wewill use the same process.

2. (Ctrl+click) the faces shown.

3. Create the toolpath.

#6: Lace Cut

1. Deselect the operations and faces.

2. Change the Cut Angle to zer0 degrees.

3. (Ctrl+click) the faces shown.

4. Create the toolpath.
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5. Render the operations.

#7: Contour with the Profiler

The next operation will be a contour operation using the Profiler to finish the flat face in the
cavity.

1. Activate the Profiler.

2. Right-click the Profile and choose Profiler Depth….

3. Interrogate the flat face in the cavity to load
its depth into the Profiler Depth dialog.

The depth of the face should be –2.5mm.
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4. Create this Contour processwith the 25mm
Finish EM (Tool #3).

The Cutting Direction will become
disabled after selecting the profile.

5. Set themachiningmarkers as shown along the green
profiler line.

6. Create the toolpath.
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#8: Corner Cleanup

The Last thing wewill do is use a small tool to finish the corners of the part. Wewill use an
Intersections-Faces Surfacing operation to accomplish this.

1. Select the faces shown.

The corners of each of these faces havematerial the 6mmball endmill left behind.

2. Create this Surfacing processwith the
3mmBall Endmill (Tool #4).

3. Create the toolpath.
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4. Render the operation.

5. Save the file.

#4: The Remote Control
In this exercise, we will machine the cavity that was created in the correspondingmodeling
exercise.

Part Set-up

1. Open the Remote.vnc file that was created in Solid Modeling Exercise #5.

Make sure that you open the .vnc file containing the core and cavity part models and not the x_t
file, which was the Parasolids file that we originally imported.

2. In the Document Control DialogMachining
Preferences tab, set the Global Settings as shown
and add a Clearance value of 15mm.

Positioning the Part

Before we canmachine the cavity we need to position the “Final Cavity” body so that it can be
machined from the standard XY plane.
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1. Select the cavity body andModify>2D
Rotate the body 180° clockwise in the YZ
plane. Then,Modify>Translate the body
down in Z by –27mm.

Tool List

1. Create the following tool list.

# Type Total Length Diameter BottomRadius # Flutes Flute Length Material

1 FaceMill 38mm 65mm 0mm 4 15mm TiN Coated
2 Rough EM 38mm 15mm 0mm 4 6.3mm HSS
3 Ball EM 38mm 9mm n/a 4 12mm TiN Coated
4 Ball EM 38mm 4mm n/a 4 20mm TiN Coated
5 Ball EM 38mm 2mm n/a 4 6.3mm TiN Coated

Machining the Part

#1: Face Mill

First, we will create an operation that will facemill the parting line surface.
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1. Create this Roughing processwith the
65mmFacemill (Tool #1).

In order to specify the correct final Z depth for the operation in the Entry/Exit Clearance
Diagram, wewill load the Z depth of a face using the interrogation tool. In this operation, we
want to cut to the depth of the first flat of the cavity.

2. Click in the final Z depth text box.

3. (Alt+click) to select the face
indicated.
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The Z depth of the selected face should be shown in
the Final Z text box as shown in the following image.

In this facemill processwe have selected the Stock option for the cut shape of the operation, so
we do not need to select any geometry or bodies to create the toolpath.

4. Create the toolpath.

Extracting the Cap

To continue themachining of the parting line body, we will lace cut the angled surface that connects
the two flat faces. In order to machine the appropriate area, we need to bring the top base body (the
Cap, which does not have the remote subtracted out) from the History list.

1. Open the History list of the Final Cavity
body and Double-click the icon in front
of the Cap item.

The Cap bodywill be brought back to the
workspace. You will need to 2D rotate and
translate this body, in the samemanner that we
originally did with the cavity, in order to get it in
the appropriatemachining position. Once this is
done, the workspace should contain a part
identical to the image on the left.

#2: Contour with Profiler

The next operation will face off the lower flat of the cavity parting line. Wewill use a contour
processwith the Profiler to accomplish this.

1. Turn on the Profiler. Right-click the green grid and choose Profiler Depth.
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2. Interrogate the face shown.

The Profiler now has the depth of the face. If you click Apply your part will look like the image
shown here.We are not going to use this value.While the Profiler gives us the correct data (the
lowest point of this face is Z-10.737mm), we need the Profiler to be on the lowest part of the
angled face.Wewill adjust the depth data.

3. Modify the Profiler Depth to -10.736 mmand
clickApply.

The 0.001mmdifferencemoves the Profiler so that it actually lies around the area that we need,
not the actual bottom boundary of the face. Switch off Profiler.
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4. Create this Contour processwith the 65mm
FaceMill (Tool #1).

We need to set themachiningmarkers on the Profiler and select the angled face to provide the
cut shape process.

5. Set themachiningmarkers as shown, Ctrl-click the angled face and create the toolpath.
Switch off the profiler.
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#3: Lace Cut on the Angled Face

1. Create this Surfacing processwith the
9mmBall EM (Tool #3).

2. In face selectionmode, select the angled face of the Cap body.

3. Create the toolpath and render the operations.

4. Place the Cavity Base body into the Body Bag as it will be used in a future operation.

#4: Roughing the Pocket

Now, wewill rough out the cavity using a roughing operation.
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1. Create this Roughing processwith the
15mmRough EM (Tool #2).

Notice that we have specified Pocket Stock and Island Stock in the Roughing process dialog. This
will leave stock in X and Y only, not in Z. The Surface Stock specification, found in the Solids tab,
will leave stock in all three dimensions.

2. Enter the following information in the Solids
tab.

3. Select the faces that compose the inside of the cavity.
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It may be easier to select the entire part model and then deselect the surfaces not to be
included.

4. Create the toolpath.

5. Render the operation.

#5: Semi-Finishing the Pocket

Wewill now create a semi-finishing operation for the cavity.
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1. Create a Surfacing processwith the 9mm
Ball EM (Tool #3).

2. Select the faces that compose the inside of the cavity.

3. Create the toolpath and render the operation.

#6: Finishing the Pocket.

The next toolpath wewill generate will finish the inside of the cavity. Wewill use the same selection
as the last operation.
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1. Create a Surfacing processwith the 4mm
Ball EM (Tool #4).

This operation will create a lace cut with a very small stepover amount to give us a nice smooth
finish on the inside of the cavity.

2. Create the toolpath.

#7: The Buttons

The final operation will finish around each of the buttons in the cavity. To accomplish this, we will
use an intersection cut on the bottom faces of the cavity.
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1. In face selectionmode, select the two
bottom faces of the cavity, Right-click
the faces and choose Select>Select Tangent
Faces.

The resulting selected faces should be all of the faces in the cavity except for the vertical walls
and the tops (and some edges) of the buttons, as seen below.

2. Create this Surfacing processwith the
4mmBall EM (Tool #4).
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To get the toolpath to wrap around all of the button
islandswe need a very large included angle and we
need to override the default tolerance settings. Click
the Advanced Settings checkbox.

This processwill create a single operation which finish around each of the button islands.

3. Create the toolpath and render the operation.

When rendered if you look at the results closely you will see that toolpath is not fully cutting
around two of the shutoffs. This is because of the tool size and how close the shutoffs are. This
area could bemachined in several ways or could just be ground out. For this tutorial we won’t
worry about it, but there is a lesson in this — always check the rendered part before sendingG-
code to the control.
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ADVANCED 3D EXERCISES
The part models for all of the exercises are supplied on the installation CD.We assume you are
familiar with the interface and the principles used inMill and Advanced CS.

All parts in these exercises are set to bemade of cast aluminum alloys. The feeds and speeds are
all system defaults. The exercises do not provide a step for setting thematerial but if you have
CutDATA, please set the part material when you open the part file. If you do not have CutDATA
you will be using the default material — stainless steel. The feeds and speedsmay be set by clicking
on the calculation buttons.

It is advisable that all rendering be done using Op Sim and that the Skip Unselected Ops icon
option is enabled (it will turn blue). These tutorials are designed to get you familiar with the
functions, not to actuallymachine the part. As such, stepovers and toleranceswill be loose to speed
up processing and to allow you tomore easily see the toolpath.

#1: The Mold Cavity
• Part Setup

• Roughing theMold Cavity

• Finishing theMold Cavity

Part Setup

In this exercise, we will explore the balance between toolpath processing time and toolpath quality.
First, we will use Advanced 3D Machining to rough the part. Next, we will see various strategies of
roughing and finishing using Advanced 3D Machining. Finally, we will use simple contouring to
finish the part.

1. Open the Adv3D#1Mold Cavity.vnc part supplied on the installation CD.

2. Verify the following tool list.

# Type Length Flute
Length Diameter Bottom

Radius
#
Flutes

1 Rough EM 3.0 1.75 1.0 0.015625 3
2 Rough EM 2.5 1.5 0.5 0.015625 3
3 Finish EM 2.5 1.5 0.375 0.015625 3

Roughing the Mold Cavity

The sample part to be used for this tutorial is Adv3d#1Mold Cavity.vnc and can be found in the
sample parts folder. Completed files are also supplied in order to demonstrate the various
strategies employed.
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The Steps

To rough out the cavity we will use several methods and strategies. Wewill start with a simple
Advanced 3D Roughing technique. From there wewill expand the number of processes and
techniques to produce different results.

• Strategy A will add a second process to help to roughmachining areas that weremissed.

• Strategy B will increase the amount of processing time but reduce the amount of toolpath by
doing Rest Material operations.

• StrategyC (Operations #3-4) will decrease the amount of processing time but increase the
amount of toolpath by using a Bounding Box definition.

• StrategyD (Operations #5-7) will use either Strategy B or C to semi-finish the part.

Operation #1: Roughing

First, we will create anOperation to rough the cavity.

1. Create a new Advanced 3D Machining Processwith the 1.0 Rough EM (Tool
#1).

For now, wewill usemostly default values.

2. Click the Restore Defaults button, and then
enter values as shown. The Advanced
Settings do not need to be changed.

Clicking the Restore Defaults button ensures that we are going to get correct automatic
values, particularly for the stepovers and cutting tolerance, based on our tool size aswe enter
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data. TheMin. Stepover andMax. Stepover values shown are 50 percent and 90 percent of the
tool’s flat bottom diameter, and Z-1.5 is the cavity floor depth.

3. Close the Process dialog.

4. Select all (Ctrl+A) faces of the part body.

5. Click the Do It button to generate Operation #1.

In the Top view, if you zoom in on the area near the right-side boss as shown, you will notice
sharp corners. Advanced 3D lets you smooth those corners for high speedmachining.Wewill
adjust the process settings to add corner rounding.

An example of Sharp Corners in the toolpath

6. Open the Process.

7. Select Profile Smoothing and enter values shown to the
right.

8. Click Redo to recalculate the toolpath.
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Notice in the area near the right-side boss that the formerly sharp corners are now rounded, as
shown.

An example of Rounded Corners in the toolpath.

9. Render the part.

Notice that material remains near the right-side boss. This is because the 1.0 tool diameter is
too large to fit between the boss and the cavity wall. To correct this, we will use a smaller-
diameter tool, experimenting with several strategies.

Roughing, Strategy A

1. Leave the Process tile for Operation #1 on the process list as wewill use this again.

2. Create a new Adv3D Operation using the 0.5 Rough EM (Tool #2) onto the new Process.
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3. Enter the values as shown for the Surfs tab.
The Advanced Settings do not need to be
changed.

4. Close Process #2 and ensure that the part is still selected.

5. Ensure that the Operation #1 tile is still selected and then click Redo to recalculate the
toolpath.

If your computer has
multi-core processors,
notice that both
processes are
calculating
simultaneously, as
shown. Keep the Task
Manager open for later
comparison, by clicking
the pin symbol.

6. Select Operation #2 and redraw (Ctrl+R) or (View> Redraw) it.

Notice that toolpath is now calculated inside the four through holes and in the corners of the
part.

7. Open Process #2, click theOptions tab, and enter
the value 2.0 forMinimum Pocket, as shown.
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8. Close Process #2 and ensure that the part is still selected.

9. Ensure that both Operation #1 and #2 tiles are highlighted and then click Redo to recalculate
the toolpath.

Notice that there is no longer any toolpath for the four through holes and in the corners of the
part. This is because the holes are 2.0 in diameter and Small Pockets Control has not allowed the
toolpath engine tomachine any pocket equal to or smaller than 2.

Operation #2 is “cutting air” in the cavity. Because this is undesirable, we will further adjust
Process #2, experimenting with two different Boundary / Stock Management strategies.

Roughing Strategy B - Rest Material

1. Open Process #2, Boundary tab, and enter
the values as shown, with Stock
ManagementRestMaterial checkbox
enabled.

Using a Pass Extension value of 0.1 forces the tool to start cutting 0.1 away from the rest material.
Using a Stock Offset value of -0.05 forces the tool to not cut anything with less than 0.05
remaining (rest) material. Using the Stock Model option 3DModel forces the tool to look primarily
at remaining (rest) material in the Z-axis.

2. Close Process #2.

If the 3D TaskManager is still open, take note of the Elapsed Time of Operation #2 from the
previous toolpath calculation. Strategy B (Rest Material), will require more processor time to
analyze the toolpath. Also, during the calculation, the status of Operation #2 will be Blocked. This
is becauseOperation #2must now wait for the preceding operation to complete before it can
begin to analyze the Rest Material condition.

3. Click Redo to recalculate the toolpath.

In the 3D TaskManager, notice that the Elapsed Time is greater than for Strategy A.

4. Change to Isometric View (Ctrl+I), clickOperation #2 and redraw (Ctrl+R) it.

Notice the toolpath has been automatically trimmed to the Rest Material that Operation #1 did
not cut.

5. Render the results.
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Notice the superior results compared to Strategy A alone, but also the greater elapsed time.

Strategy A Strategy B

Roughing Strategy C - Bounding Box

1. Close the rendering palette.

2. Double-clickOperation #2 to select both operations.

3. Open Process #1 and change the finish Z-depth value to -1.25 (the boss tops).

4. Verify that the Z Step value is 0.125 and then close Process #1.

5. Open Process #2 and change the start Z-depth to -1.25 (the boss tops) and the finish Z-depth
to -1.5 (the floor).

6. Verify that the Z Step value is 0.125.

7. Click the Boundary tab and in Stock Management, Stock Type uncheck the Rest Material
checkbox.

8. Close Process #2.

9. Select all (Ctrl+A) again and click Do It to calculate a new toolpath.

Notice in the TaskManager that Operations #3 and #4 are being created simultaneously, saving
programming time. Process #2may finish calculating before Process #1.
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10. Select Process #3 and redraw it.

Notice that the toolpath stops above the boss tops.

11. Select Process #4 and redraw it.

Notice that the toolpath begins at the boss tops andmachines down to the cavity floor.
However, it alsomachines 100% of the floor, requiringmoremachining time.

12. Render the toolpath.

If you interrogate the depths of the floor, boss tops, and top flat (you can use the plug-in named
Show Position), the values are not Z-1.5, Z-1.25, and Z-0.1. The following processes, strategyD,
correct this.

Semi-Finishing Via Flats Cut, Strategy D

1. Double-click roughingOperations #1 and #2.

Alternatively, if you preferred StrategyC to Strategy B, you could select roughingOperations #3
and #4. Strategy B (#1-2) used RestMaterial to reduce the amount of toolpath. StrategyC (#3-4)
used Bounding Box to decrease the processing time for dual-core or quad-core processors.

2. Create a new Advanced 3D Machining Process #3 with Tool #3.
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3. Changemachining strategy to Flats Cut and
enter values as shown.

4. Close Process #3.

5. Click Do It to calculate the toolpath.

Let’s look at the TaskManager for amoment, specifically the Status column.What it displayswill
depend upon which strategy you are using and also your computer’s central processor unit
(CPU).

Strategy B

If you are calculating the
toolpath using strategy B
(Ops #1-2), you will see
that Processes #1 and #2
are running simultaneously,
but Process #3 is Blocked.
This is because it is using
RestMaterial and it is
dependent on the results of
Operation #2 and thus
cannot begin running until
Process #2 is completed.

StrategyC,
Dual Core
Processor

If you are calculating the
toolpath using strategyC
(Ops #3-4) on amachine
with a dual-core processor
you see that Processes #1
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and #3 run simultaneously
while Process #2 isQueued.
This is because the
computer has only two
processors available.
Process #2must wait in a
queue until one of the
processors becomes
available. Once Process #1
or #3 is complete, Process
#2 begins running.

StrategyC,
Quad Core
Processor

If you are calculating the
toolpath using strategyC
(Ops #3-4) on amachine
with a quad-core
processor, you see that
Processes #1, 2, and 3 all
run simultaneously. With
four processors available,
and with no process
dependent on another
process, a quad-core
machine is able to run all
three processes
simultaneously.

As a result of the calculation, new Operations #5-7 are created. However, the new toolpath has
several problems, most notably the cutting on the top face of the part at Z-zero. Other problems
are less noticeable because the toolpath is shown for all three Operations.

6. Select Operation #7 and redraw (Ctrl+R) it.

Notice that the boss tops at Z-1.25 have not been cut. Also, it is clearly visible that Flats Cut is
machining the top of the part at Z-zero, which is undesirable. First, we will correct only the boss
tops at Z-1.25.

7. Double-clickOperation #7 to select Operations #5-7.

8. Open Process #3,Options tab, and change the value ofMinimum Pocket to 0.0.

9. Close Process #3.

10. Click Redo and wait for the toolpath to recalculate.
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11. ClickOperation #7 and redraw it.

Notice that the toolpath now machines the boss tops. This is because the boss tops have
diameter less than 2.0 but greater than zer0.

12. Render the toolpath.

If you use the Show Position plug-in to interrogate the depths of the floor, boss tops, you find the
values are now correctly Z-1.5, Z-1.25, and Z-0.1.

However, the toolpath is still machining the top of the part. Wewill correct this next.

Refining Toolpath, Strategy A - Selected Curves

Wewill correct themachining of the top of the part by containing the toolpath within the cavity area.
Wewill experiment with two of the possible strategies.

1. Select the top face and extract the
geometry.

This yields a closed geometry loop around
the top edge of the cavity.

2. Double-clickOperation #7 to select Operations #5-7.

3. (Ctrl+click) the closed geometry loop around the top edge of the cavity.

4. Open Process #1, Boundary tab.

In Boundary Style, Boundary Type, notice that Selected Curves is active. If you now open Processes
#2 and #3, you would notice that they automatically default to Selected Curves and are disabled.
This is because all three processes in the groupmust use the same Selected Curves for the
Boundary Type.

5. Close the process.
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6. ClickDo It to calculate a new toolpath.

This creates three new Operations: #8, #9,
#10.When the calculation has completed,
notice that the toolpath for each operation is
now contained within the geometry loop.

Alternatively, we can employ a different strategy, Silhouette, to refine the toolpath.

Refining Toolpath, Strategy B - Silhouette

1. Deselect the highlighted operations and then redraw.

2. Activate Face Selection.

3. Right-click the cavity floor (Z-1.5) and choose Select>Select Faces Above.

4. (Ctrl+click) the boss tops (Z-1.25).

At this point, all cavity faces are selected, but the faces outside the cavity are not selected and
the geometry is not selected.

5. Open Process #1, Boundary tab, and in Boundary Style, Boundary Type, select Silhouette.

If you were to open Processes #2 and #3 now, you would notice that they automatically default
to Silhouette and are disabled. This is because all three processes in the groupmust use the
same Silhouette for the Boundary Type.

6. Close the process.

7. ClickDo It to calculate a new toolpath.

This creates three new Operations: #11,
#12, and #13.When the calculation has
completed, notice that the toolpath is now
contained within the silhouette boundary of
the cavity.

It is now time to use the finishing tools. First we will use Contour to finish themain cavity. Then
wewill use several different optimization techniques.
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Finishing the Mold Cavity

Finishing and Optimizing

1. Delete the three existing processes.

2. Create a new Advanced 3D Machining processwith the 2.5 Rough EM (Tool #3).

3. Change themachining strategy to Contour.

For now, wewill usemostly default values.

4. ClickRestore Defaults, and then enter
values as shown.

5. Click theOptions tab, and thenmake changes to ConnectMove Control and Point Reduction as
shown.
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6. Click the Boundary tab, and thenmake changes to Boundary Style and BoundaryMode as
shown.

7. Close the process.

8. Select the faces to bemachined as
shown.

Be sure to select both bosses. Each boss has two small radii (top and bottom) and a small wall
between the radii. This can be accomplished using the selection we used earlier and
deselecting the floor.

9. Click Do It to calculate a new toolpath and generate Operation #14.

In this new Operation (#14), you will notice several problems, such as air-cuttingmoves just
above the edge of each silhouette boundary.

In the following steps, we will optimize the toolpath to remove the air-cuts andmake a better
quality surface finish. Wewill make one change at a time to see the resulting changes
individually.

Optimization, Step 1

1. Double-clickOperation #14 to select the silhouette faces.

2. Open the process, Boundary tab, and select the checkbox for Contact Area Only.
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3. Close the process, and then click Redo.

After the calculation has completed, notice that the toolpath is no longer making air-cuts. This is
because of the Contact Area Only option, which causes the toolpath engine to treat Silhouette as a
3D-type boundary that recognizes and trims the 3D material. (In contrast, when Contact Area
Onlywas disabled, the toolpath engine treated Silhouette as a 2D-type boundary that did not use
3D material recognition.)

Optimization, Step 2A

1. Double-clickOperation #14 to select the silhouette faces.

2. Open the process, Boundary tab, and enter 0.1875 as the value for Extra Offset.

3. Close the process and then click Redo.

After the calculation has completed, notice that the toolpath now extends an extra amount (the
tool's radius) past the edges of the selected faces.

Optimization, Step 2B

1. Double-clickOperation #14 to select the silhouette faces.

2. Open the process, Boundary tab, and enter 0.0 as the value for Extra Offset.

3. Close the process.

4. (Ctrl+click) the cavity floor and then click Redo.

After the calculation has completed, notice that the toolpath now extends an extra amount (the
tool's radius) past the edges of the selected faces.

In these examples, both 2A and 2B produced the desired results with virtually identical results.
However, on other parts, one strategymight work better than the other.
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Optimization, Step 3

Find the lead-in helix on the pocket wall
and look closely at the connectionmoves,
as shown. Notice that the connect moves
are vertical. In this step, we will change the
connect method, to produce a better
surface finish with reduced tool pressure
and tool wear.

1. Double-clickOperation #14 to select the silhouette faces.

2. Open the process,Options tab, andmake changes as
shown below.

3. Close the process and then click Redo.

After the calculation has completed, notice that the toolpath connect moves are now angled,
with a smooth ramp from one Z-level to the next, as shown.

4. Save the file.

5. Select Operations #11-14, and then render the toolpath usingOp Sim.

6. Right-click the title bar ofOp Sim andmake sure Skip Unselected Ops is checked.

7. Right-click the title bar ofOp Sim and choose Settings.
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8. Enter values as shown.

9. Close the Settings dialog and
then runOp Sim.

After the rendering has
completed, mouse-zoom from
an isometric view so that you
can see the top radius and the
floor and boss radii. Notice
that the floor has some
material remaining and also
notice that the top radius is
rough-looking, with large
steps.Wewill fix both
problems in the next step.
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Optimization, Step 4

1. Double-clickOperation #14 to select the silhouette faces.

2. Open the process,Options tab, andmake changes as shown.

In the Step Down Control area, the Adaptive option is selected, and the step down values are
0.001, 0.004, and 0.015.

3. Close the process, and then click Redo.

After the calculation has completed, notice that the toolpath hasmanymore step-down passes
at the fillets.

4. Save the file.

5. Select all four of Operations #11-14, and then render the toolpath usingOp Sim.

After the rendering has completed, mouse-zoom from an isometric view so that you can see the
top radius and the floor and boss radii. Notice that there is nomaterial remaining at the floor and
that the top radius is smooth-looking, with small steps.
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6. Save the file.

#2: The Food Bin
In this exercise, we will explore five different types of toolpath for a simplemold core:

1) Tool Holder Goug Checker

2) Flats Cut

3) Lace Cut

4) Toolpath Splitter; and

5) N-Curve Flow

The goal of this tutorial is to familiarize you with various toolpath options.

Part Setup

1. Open the Adv3D#2 Food Bin.vnc part supplied on theGibbsCAM installation CD.

2. Verify the following tool list.
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# Type Length Flute Length Diameter Bottom
Radius

Length Out of
Holder

1 Rough EM 100 11 25 1.0 12
2 Rough EM 100 22 25 1.0 23
3 Rough EM 100 32 25 1.0 33
4 Finish EM 100 32 25 0 33
5 Finish EM 50 25 6 .75 27.5
6 Finish EM 50 25 6 .75 27.5
7 Finish EM 50 25 6 0 27.5
8 Ball EM 75 28 6 n/a 30
9 Ball EM 75 28 6 n/a 30
10 Ball EM 50 15 6 n/a 20

Machining the Food Bin

#1-4: Roughing

For roughing the part we will use Tools #1-4, the 25mmendmills. In Processes #1-3, we rough the
part with progressively longer lengths out of the holder. Then in Process #4 wewill use Tool #4 to
make a Flats Cut.

1. (Click-Shift+select) Tools #1-4 and drag them to the process list.

The four tool tiles populate the first four list positions.

2. (Double-click Process Tile #1 and choose Advanced 3DMachining.

3. Click Restore Defaults.

4. Verify that theOperation Type is set to Pocketing.



Advanced 3D Exercises

111

5. Enter values for the Surfs tab as
shown.

6. Click the Entry/Exit tab.

7. Change the Retract Style toMinimal Vertical, and set the value of Clear Surface By to 10.

This will cause the tool to maintain a distance of at least 10mmabove the surface of the part
whenmaking rapid links.

8. Close Process #1.

9. (Double-click Process Tile #2 and choose Advanced 3DMachining. Use the same settings as
in Process #1.

10. (Double-click Process Tile #3 and choose Advanced 3DMachining. Again, use the same
settings.

11. (Double-click Process Tile #4 and choose Advanced 3DMachining. Change theOperation Type
to Flats Cut.
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12. Click Restore Defaults and then enter
values for the Surfs tab as shown.

You will make a Flats Cut to finish the floor at Z-31.75mm. You set the Surface Stock value to 0.25
to prevent the tool from touching the core’s walls. However, because this prevents the tool from
cutting the floor, you set the Z Stock value to -0.25, which will shift the tool down to the floor
depth.

Also, sinceOperation #3 will leave approximately 1.75mmof material on the floor, the Axially
Offset Control is used tomakemultiple Z-steps. In this example, the Axially Offset Times value of 2
will add two additional Z-steps above the final Z-step, for a total of three Z-steps. The Axially
Offset Step value of 0.5mmwill make the first pass 0.5mmabove the finish floor depth, leaving
that amount for the finish pass at Z-31.75.

13. Click theOptions tab, change the Smooth Radius value to 12.5, and change theMaximum Stay
On Surf value to 320.

Setting the Smooth Radius value to 12.5 will cause the connect moves from one stepover to the
next to be blended with a 12.5-mm radius, allowing for higher feedrates. Setting theMaximum
Stay On Surf value to 320 will cause the tool to cut the entire floor area without retracting until the
end of each Z-step.

14. Close Process #4.

15. Select the solid (the entire part) and then click Do It to generate the operations.

After all four processes have run, you haveOperations #1-4. Wewill useOp Sim inOp Stop
mode to clearly see the results of each operation.

16. In the Top taskbar, ensure that Tool Holder Display is enabled.
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17. OpenOp Sim and then clickOpColor mode button.

18. Set theOp Color Mode option toOp Number.

19. Select the Stops option and set the Stop before Operation number to 2.

20. RunOp Sim.

Notice that Operation #1 cuts as close as possible to the core, but leavesmaterial where the
holder would gouge the part.

21. Resume the rendering.

Operation #2 cuts remaining (rest) material that Operation #1 could not, and likewise with
Operation #3.

22. Delete the four processes.

23. Save the interim part, which now hasOperations #1-4.

#5-7: Roughing and Finishing

In this section wewill use Tools #5-7 (6mm-diameter endmills) to rough and finish the lid area. Tool
#5, a rough endmill with a 0.75mm tool nose radius, will rough the entire lid area. Tool #6, a finish
endmill with a 0.75mm tool nose radius, will finish the areas that have fillet radii between the floor
and wall. Tool #7 is a finish endmill without a tool nose radius (zero). Wewill build three processes
for this group of operations.

1. (Click-Shift+select) Tools #5-7 and drag them to the process list.

The three tool tiles populate the first three process list positions.

2. (Double-click Process Tile #1 and choose Advanced 3DMachining.

3. Ensure that theOperation Type is set to Pocketing and then click Restore Defaults.

4. Click Advanced Settings and then select the option Profile Ramping.

Profile Ramping causes all entrancemoves to be done with a rampmove instead of a helix.

5. Close the Advanced Settings dialog box.
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6. Enter values as shown for the Surfs
tab.

The Z start depth value at the top of the lid area allows you to select the entire solid, not faces or
geometry for containment, and it does not require the use of Rest Material from previous
operations. As a result, when this strategy is used with a group of processes, the calculation
time ismuch faster by allowing the processes to calculate simultaneously. The benefits from
using this strategy are the ease of model selection and the increased speed at which the
processes are calculated.

7. Click the Entry/Exit tab and choose the Vertical option for the Entry and Exit styles.

8. Click the Boundary tab and ensure that Boundary Type is set to Part Bounding Box and that Stock
Type is set toNone.

9. Close Process #1 and (Double-click Process Tile #2 and choose Advanced 3DMachining.
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10. Click the Surfs tab and enter values
as shown.

This Flats Cut processwill finish the floors and walls that have a 0.75mm radius. You set the Z
start depth to -36.449, which is equal to the floor of the second step. This also allows you to
select the entire solid, not faces or geometry for containment, and does not require the use of
Rest Material from previous operations.

11. EnsureOperation Type is set to Flats Cut and then click Advanced Settings.

12. Select the option Profile Ramping.

13. Close the Advanced Settings dialog box.

14. Click the Entry/Exit tab and choose the Vertical option for the entry and exit styles.

15. Click the Boundary tab and ensure that Stock Type is set toNone.

Notice that Boundary Type is grayed out, because Process #2must use the same Boundary Style
as Process #1.

16. Close Process #2 and (Double-click Process Tile #3 and choose Advanced 3DMachining.
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17. Click the Surfs tab and enter values as
shown.

This Flats Cut processwill finish the floor and wall that has a sharp corner. By setting the start Z
depth to just below the large flat area we can select the entire part. Also, Z final depth is set to -
34.6456, which is equal to the floor of the first step.

18. EnsureOperation Type is set to Flats Cut and then click Advanced Settings.

19. Select the option Profile Ramping.

20. Close the Advanced Settings dialog box.

21. Close Process #3. Click the empty tile below the first 4 operations.

22. Select the solid (the entire part) and then click Do It to generate the operations.

Notice in the TaskManager that Processes #2 and #3 finish calculating before Process #1. This
is a result of the strategy used tomake the processes. After all three processes have run, you
haveOperations #5-7.

23. RunOp Sim and verify the results when it completes.
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24. Right-click theOp Sim title bar and choose Create Facet Body.

25. Close the rendering palette.

The facet bodywe just
created is shown in the
workspace. It is partially
transparent. Youmay
need to place the part
model in the Body Bag
to see the facet body

26. Place the facet body into the Body Bag and set its properties to Stock – Display Only.

You can use this body as the startingmaterial condition for each subsequent Sim rendering.
Note that if the facet body properties were set to Stock, then each subsequent toolpath process
would set the Stock Management, Stock Type to Solid (in other words, amaterial-only starting
condition).

27. Delete the three processes.

28. Save the interim part, which now hasOperations #1-7.

#8: Lace Cut

Wewill finish the “flat” walls of the core with lace cuts.

1. Create an Advanced 3D Machining process the 6mmBall EM (Tool #8).
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2. Click on Restore Defaults and enter the
values as shown.

This will create toolpath parallel to the X-axis. We have set the stepover very loose on purpose
so that the processing time is very quick and we can easily see the results.

3. Close the process.

4. Ensure Face Selectionmode is enabled.

5. Right-click one of the angled walls on the core and choose Select>Select 3D Faces.

6. (Ctrl+click) the top face of the core.

7. Click Do It to generate the new operation.

We can see that default lace
cut settings are going to try to
machine all of the walls. We
want these walls to be
machined up and down, not
across the faces.
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8. Open the process dialog and click on the
Advanced Settings button. Set the values as
shown.

Crossmachining creates toolpath perpendicular to the cutting direction. By setting the Cross
Machining Control to “Only” we have eliminated all of the toolpath that is parallel to our Cut
Angle.

9. Click Redo to recreate the operation.

#9: Lace Cut on the Long Walls

Wewill continue what we did on the walls parallel to the X-axis but modify the process to cut the
long walls.

1. Open the process for Operation #8 and
change the cut angle to 90. Click Do It to
create a new operation.

This operation is good but it creates toomuch wear on the tool.
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#10: Lace Cut Toolpath Splitter

Wewill now split the toolpath of Operation #9 into two operationswith two separate tools. When
using Toolpath Splitter, be sure to use two or more identical tools (in this case, Tool #8 and Tool #9).
When the toolpath is split, notice that the split will be created at a safe area in the toolpath.

1. Create an Advanced 3D processwith the second 6mmBall EM (Tool #9) in
Process tile #2.

2. Set the cut type to Toolpath Splitter.

3. Click Redo.

The resulting operations split the toolpath in
half.

If Operations #8-10 are rendered, the part will look as below.
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4. Delete the process tiles.

#11-14: Lace Cut - Radial with Up Machining

Wewill now create toolpath on the 3D corners. Wewill accomplish this using a radial lace cut.

1. Create an Advanced 3D Machining Lace Cut process using the 6mmBall EM (Tool #8).

2. Click the Restore Defaults button and set the values as shown. Click Advanced Settings to input
the Lace-Radial settings.

The primary changeswemake here are the Normal-Vector
Range values and the Lace Style. The center coordinates
for the radius can be easily acquired by interrogating the
point in the X-Y- quadrant of the part (the point closest to
you when the part is in isometric view.)

3. Click theOptions tab and setMinimum Pass Length to 6.0.
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Using aMinimum Pass Length of 6mmwill prevent the tool frommachining the floor of the lid area,
when the faces are selected in the next few steps.

4. Click the Entry/Exit tab and set the Entry Style and Exit Style to Vertical. Use the default value of
1.5.

5. Click the Boundary tab and verify that the Boundary Type is Silhouette.

6. Close the process.

7. Select the faces as shown and click Do It to generate the new Operation (#11).

That is acceptable toolpath but we want to machine uphill only and wewanted toolpath that arcs
on and off the part.

8. Open the process dialog and change the Cutting Strategy to Upward. Also change the Entry/Exit
values as shown.

9. Click Redo to recreate the toolpath.
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Looking at the part from the side we can clearly see the
arcingmotion on and off of the part.

10. Create this operation threemore times. Each time select a new value for the radius center point
by interrogating the point and selecting the 3D faces on the corners. Work counter clockwise to
create a total of four individual Operations (#11-14). No other process data needs to be
changed than the radius center.

11. Select Operation tiles #8-14. Enable the Skip unselected ops function (it turns blue). Run
the rendering.

When rendered, the part will look similar to the image below.

12. Delete the process tile.
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#15: N-Curve Flow

The last operation will machine the rounded top edges. It is a challenge tomake a good contour-
style toolpath without retracts for the 8.5mm radius around the top of the core. The best strategy to
accomplish this isN Curve Flow, as described in the following steps.

1. Deselect all operations so you can clearly see the part and geometry.

The workgroup in this part contains two closed geometry profiles. Both profiles were extracted
from themodel’s 8.5mm radius using a Force Depth to Z-zero. Next, the top profile was offset
inward a small amount to allow for some overlap of the toolpath onto the top surface. The lower
profile was offset outward by 4.5mm (75%) of the tool’s radius to allow the contact point to reach
the bottom of the 8.5mm radius.

When using this strategy, the amount that the curves are offset may be different from one part to
the next depending upon the feature angles at which the toolmust make contact. For example,
more-vertical anglesmay require a larger offset; less-vertical anglesmay require a smaller
offset.

2. Create a new Advanced 3D Machining process using the 6mmBall EM (Tool #10) and set the
Operation Type toN Curve Flow.

3. ClickRestore Defaults and then enter
values as shown.

Notice the change of Cutting Strategy option to Unidirectional.

4. Click the Drive Curves button to open the Select Drive Curves dialog box.



Advanced 3D Exercises

125

5. Select both of the drive curves in the workgroup, making sure that the drive curve arrows point
in the same direction.

When you select a connector point, the arrow will first point in the default direction. To reverse
the arrow direction, (Ctrl+click) the element on the opposite side of the connector point. To
reverse the arrow back to its original direction, (Ctrl+click) the element in the original
direction. (When you (Ctrl+click) the element in the original direction, you are actually
deselecting and removing the element from the selection dialog, thus causing the arrow to
return back to the default direction.)

6. ClickOK to close the Select Drive Curves dialog box.

7. Click the Boundary tab and enter values as
shown.

8. Close the process, select the body and then
click Do It to generate Operation #15.

When the calculation is complete, you will
see a 3D contour style of toolpath with only
one retract.

9. Ensure that Operations #8-15 are selected and that Skip Unselected Ops is still active. Render
the part.

When rendered, the part will look similar to the following.
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10. Save the final part.

#3: The Mold Core
In this exercise, we will explore four different 3D toolpath options: 1) Constant Stepover; 2) Steep
Shallow Cut; 3) Intersections; and 4) IntersectionsRest. The goal of this tutorial is to familiarize you
with various toolpath options. Although other operation typeswill also be used, theywill not be
explained in detail, as theywere covered in previous Advanced 3D Machining tutorials.

Part Setup

1. Open the Adv3D#3Mold Core.vnc part supplied on theGibbsCAM installation CD.

2. Verify the following tool list.

# Type Length Flute Length Diameter Bottom
Radius

Length out of
holder

1 Rough EM 60 25 25.00 0 35
2 Rough EM 50 25 12.50 1mm 25
3 Ball EM 75 25 12.50 n/a 35
4 Ball EM 75 25 6.00 n/a 40
5 Ball EM 50 10 2.50 n/a 22

Roughing the Part

#1: Roughing the Pocket

For Operation #1, we will use Tool #2 to rough the pocket at the top of the part.

1. Create an Advanced 3D Machining processwith Tool #2.
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2. Verify thatOperation Type is set to Pocketing and then click Restore Defaults.

3. Enter values as shown for the Surfs tab and
for Advanced Settings.

4. Set the values for theOptions and Entry/Exit
tabs as shown.

5. Click the Boundary tab and set the Boundary Type to Silhouette.

6. Close the process.
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7. Ensure that Face Selection is turned on.

8. Right-click the pocket floor and choose Select>Select Faces Above.

9. Verify that all faces inside the pocket are
selected, as shown.

10. Click Do It to generate Operation #1.

Next, you will adjust several settings that will allow you to runOp Simmore rapidly and to detect
collisions between the tools/holders and the part.

11. OpenOp Sim.

12. Click theOp Color Mode button. Ensure thatOp Number is selected and then close the dialog
box.

This setting will allow you to seemore clearly what each operation is cutting.

13. Click the Collsion checking icon it will turn blue when enabled.

14. Right-click the title bar and choose Settings.
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15. Ensure that the values shown are set, these are the system
defaults. If they are not set, change the values and click Apply
before closing the dialog box.

16. RunOp Sim and wait until the pocketing operation is rendered.

17. Right-click theOp Sim title bar again and choose Create Facet Body.

You will use this facet body as stockwhen creating the next two operations. This technique
allows you to creatematerial-only toolpath calculation without having to create dependent
processes.

18. Close theOp Sim dialog box.

19. Right-click the facet body and choose Show Properties.

20. Click the option for Stock.

You choose Stock rather than Stock - Display Only because you will want Operations #2 and #3 to
calculate toolpath based on this stock condition.

21. Close the Facet Body Properties dialog box.

22. Place the facet body into the Body Bag.

23. Delete Process 1.

24. Save the interim part, which now hasOperation #1.

#2-3: Pocketing

For Operations #2 and #3, you will use Tools #1 and #3 to rough the outside of the part.

1. (Ctrl+click) Tools #1 and #3 and drag both tool tiles to position 1 on the process list.

2. Choose the Advanced 3DMachining tile.

Both processes are populated and Process #1 opens.

3. Verify thatOperation Type is set to Pocketing and then click Restore Defaults.
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4. Enter values for the Surfs tab and Advanced
Settings as shown.

5. Set the values for theOptions and Entry/Exit
tabs as shown.

6. Click the Boundary tab and ensure the Boundary Type is set to Part Bounding Box.

7. Double-click Process #2.

Process #1 closes and Process #2 opens. The goal of Process #2 (which will create Operation
#3) is to smooth the large Z-steps left byOperation #2 with its 25mm rough tool.

8. Click the Surfs tab, verify thatOperation Type is set to Pocketing and then click Restore Defaults.
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9. Enter values for the Surfs tab and Advanced
Settings as shown.
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10. Set the values for theOptions and Entry/Exit
tabs as shown.

11. Click the Boundary tab and enter values as
shown.

12. Close the process.

13. Turn off Face Selection and click the part body, thus selecting all faces then click Do It and
wait for Operations #2 and #3 to be generated.

14. ClickOperation #3 and redraw it (Ctrl+R).
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The toolpath for Operation #3 should be as shown.

15. Delete Processes 1 and 2.

16. Save the interim part, which now hasOperations #1-3.

#4: Flats Cut

Wewill now clean up the flat areas of the part. This is very easywith Advanced 3D.

1. Create an Advanced 3D Machining processwith Tool #2.

2. Change theOperation Type to Flats Cut and then click Restore Defaults.

3. Click the
Entry/Exit tab
and enter
values as
shown.

4. Click the Boundary tab, change the Boundary Type to Part Bounding Box, and verify that Stock
Type is set to Solid.

5. Close the process.

6. Verify that all faces of the part body are selected and then click Do It to generate Operation #4.



Advanced 3D Exercises

134

7. Delete process 1 and save the interim part, which now hasOperations #1-4.

#5: Semi-finishing, Using Constant Stepover Cut

1. Create an Advanced 3D Machining processwith Tool #3.

2. Click Restore Defaults and then change theOperation Type to Constant Stepover Cut.

3. Change the value for Surface Stock from zer0 to 0.13.

4. Click the Boundary tab and verify that Boundary Type is set to Part Bounding Box and that Stock
Type is set to Solid.

5. Click theOptions tab and setMax Stay down to 12.5.

6. Close the process.

7. Select the part body and click Do It to generate Operation #5.

When the toolpath has finished calculating, you notice that it is cutting all faces. This is
undesirable, and so you will modify the process to get a better result.

8. Open Process 1, Surfs tab.

9. ChangeMinimumAngle to 0.1 andMaximumAngle to 46.

TheMinimumAngle of 0.01 prevents the toolpath frommachining flat areas (at zero degrees),
and theMaximumAngle of 46 prevents the toolpath frommachining areas that are steeper than
46 degrees. Later, in Operation #6, you will use a different Operation Type to semi-finish the
steeper areas.

10. Click the Boundary tab, change the Boundary Type to Shallow Areas, and verify that Stock Type is
set to Solid.

11. Close the process.



Advanced 3D Exercises

135

12. Verify that all faces of the part body are selected and then click Redo to regenerate Operation
#5.

The toolpath for Operation #5 will be similar to the image below.

13. Retain the process and save the interim part, which now hasOperations #1-5.

#6: Semi-finishing, Using Contour

1. Open process 1, Surfs tab.

2. ChangeOperation Type to Contour and then click Restore Defaults.

3. Enter a value of 0.13 for Surface Stock.

4. ChangeMinimumAngle to 45 and changeMaximumAngle to 90.

TheMinimumAngle of 45 will cause the new toolpath to overlap that of Operation #5 and the
MaximumAngle of 90 will cause the toolpath tomachine all walls between 45 degrees and
vertical.

5. Change Z Step to 1.

6. Click the
Entry/Exit
tab and
enter
values as
shown.
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7. Click the Boundary tab, change the Boundary Type to Part Bounding Box, and verify that Stock
Type is set to Solid.

8. Close the process.

9. Verify that all faces of the part body are selected and then click Do It to generate Operation #6.

When the calculation is
complete, you notice that the
toolpath is cutting only the
areas (walls) that were not cut
byOperation #5, the previous
operation.

10. Delete the process.

11. Save the interim part, which now hasOperations #1-6.

#7: Semi-finishing, Using Intersections

Because of themany different radii used
on this part (see illustration), it is not really
possible to get a single Intersections
operation that will get all of the edges.We
will make an Intersections operation that
will get most of the edges.

1. Create an Advanced 3D Machining processwith Tool #4.

2. Change theOperation Type to Intersections and then click Restore Defaults.
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3. Change the value for Surface Stock from zer0 to 0.1.

4. Click the Boundary tab and verify that Boundary Type is set to Part Bounding Box and that Stock
Type is set to Solid.

5. Close the process.

6. Verify that all faces of the part body are selected and then click Do It to generate Operation #7.

When the toolpath has finished calculating, you notice that it is cutting only some of the
intersections in and around the pocket area. This is undesirable, and so you will modify the
process to get a better result.

7. Open Process 1, Surfs tab.

8. Enter a value of 6.5 for Pencil Thickness.

This will cause the toolpath to cut part radii that are larger than the radius of Tool #4.

9. Close the process.

10. Verify that all faces of the part body are selected and then click Redo to regenerate Operation
#7.

When the toolpath has finished calculating, you see that it is now cutting toomany of the
intersections. This is undesirable, and so you need to further modify the process settings.

11. Open Process 1, Surfs tab.

12. Set the process values as shown.

- The higher Cutting Tolerancewill speed up the operation generation.
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- ThemodifiedNormal-Vector Rangewill limit which faces are eligible for the Intersections
toolpath.

- The lowerMax. Included Angle and Pencil Thickness valueswill cause the toolpath to cut fewer
part radii.

13. Click on theOptions tab and set the items in the
Optimize group as shown.

This will smooth out the toolpath and remove some
toolpath with moves in Z+.

14. Close the process.

15. Verify that all faces of the part body are selected and then click Redo to regenerate Operation
#7.

When the toolpath has finished calculating, you see that it is now cutting an acceptable number
of intersections. This ismore desirable than the previous results.

16. Retain the process and save the interim part, which now hasOperations #1-7.

#8: Finishing, Using Intersections-Rest

The next three operationswill finish the part.

1. Open the process, Surfs tab.

2. ChangeOperation Type to Intersections-Rest and then click Restore Defaults.
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3. Enter values as shown.

In the Reference Tool area, you change Diameter to 12.5 so that the toolpath will makemore
offset loops, ensuring amore thorough cleanup of the part radii.

In the RestMachining Areas Control area, you change Reference Angle to 45 so as to define which
part features are steep and which are shallow.When used with the setting of All Areas it causes
the toolpath to cut steep walls like a contour cut and shallow walls like a pocketing cut. In the
dropdown list, if you were to choose Steep Areas Only (for example), it would restrict the toolpath
to cut only steep areas.

In the Stroke Sorting area, you retain the option Planar (vs. Angular) to specify that the toolpath will
first make cuts that are planar to the tool’s depth-axis (as opposed to first making cuts that are
angular to the tool’s depth-axis). The choice ofNonewould disable the sorting.

4. Click the Boundary tab and verify that the Boundary Type is set to Part Bounding Box and that
Stock Type is set to Solid.

5. Close the process.

6. Verify that all faces of the part body are selected and then click Do It to generate Operation #8.
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7. Retain the process and save the interim part, which now hasOperations #1-8.

#9: Finishing, Using Steep Shallow Cut

A Steep Shallow Cut operation is designed to be single step finishing routine. Even complex parts
can be finished with just this single operation because “steep” areas and “shallow” areas are cut
differently. Typically you do not even need to change the default values to get acceptable results.
The one downside to this operation type is that it is not fast to generate.

1. Open the process, Surfs tab.

2. ChangeOperation Type to Steep Shallow Cut and then click Restore Defaults.

3. Change the Z Step value to 0.5 and the Stepover to 2.

4. Click on theOptions tab and change both the Steep and Shallow Maximum Stay of Surf. values to
20.

This is done tominimize retracts.

5. Deselect the Depth First option.

6. Click the Boundary tab, ensure that the Boundary Type is set to Silhouette, and verify that Stock
Type is set to Solid. Also set the BoundaryMode toOn.

This will take the tool center to the edge of the part and helpminimize retracts.

7. Close the process.

8. Verify that all faces of the part body are selected and then click Do It to generate Operation #9.

9. The processwill take at least several minutes to complete.
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You can see how the XY moves are offset by 2mmwhile the Zmoves are 0.5mm.

10. Retain the process and save the interim part, which now hasOperations #1-9.

#10: Finishing, Using Intersections-Rest

The last thing we are going to do is finish the small rounded edges inside the pocket.

1. Drag Tool #5 onto the existing process.

2. Click the Surfs tab, change theOperation Type to Intersections-Rest, and then click Restore
Defaults.
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3. Enter values as shown.

4. Click theOptions tab and changeMinimum Pass Length to 5.

By increasing this value, we are preventing some small segments from being cut because they
do not need further machining. This ismost notable in the transition area from the small radius to
the larger radius edges and the top, outer edges.

5. Click the Boundary tab, change Boundary Type to Silhouette, and verify that Stock Type is set to
Solid.

6. Close the process.

7. Turn Face Selection on.

8. Right-click the pocket floor and choose
Select Faces Above.

Verify that all faces inside the pocket are
selected, as shown.
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9. Click Do It to generate Operation #10.

We can see that the toolpath is limited to the
small radius edges.

10. Delete the process and save the final part, which now hasOperations #1-10.

When rendered, the part will look similar to the following image.

11. Save the part as the tutorial is now complete.
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QUICK EXERCISES
• Building a Spherical Ellipse

• Replace History

• 2D Contour

• Advanced 3D, Using Curves

Building a Spherical Ellipse
You need to create a concave elliptical where the lowest point is in the center.

The problem is that the print specifies values
for one quadrant of the 3D shape; this is how
wemight normally go about building the part,
one quadrant at a time.We build the first
quadrant and then create a “Coons Patch”
between the geometry. We then duplicate and
mirror the Coons Patch sheet over the X and Y
center lines and stitch the sheets together.
This result looks like the finished shape we
want.

However, there is a problemwith thismodel
that cannot be clearly seen until the part is
machined. If you turn on “Show Edges”, you
can see the intersecting lines running through
themodel. These intersecting lines run
parallel to the X and Y axes at the centerline.
When the part ismachined, these lineswill
show up as if they have beenmagnified. The
model, not themachining, is the cause of the
problem.

Is this problem unique to GibbsCAM?No, this is the result of poor modeling techniques and will be
reproduced in any other CAD or CAD/CAM system unless a better set of modeling techniques is
used. GibbsCAM ismachining themodel exactly as it was built.

The solution to creating a single continuous 3D flowing shape is to create a “3 Point Arc” on the XZ
CS, another “3 Point Arc” on the YZ CS and then Sweep a sheet over these two arcs. Follow the
steps below:

Step #1

1. Create an XZ plane.
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2. Create points at X–35, Y0, Z0 then at X0, Y0, Z–8 and lastly X+35, Y0, Z0.

3. Select the points we just created.

4. Create a “3 Point Circle” (the circle will have a radius of 80.563mm).

5. Terminate the circle with the points at X–35 and X+35.

Step #2

1. Create a YZ plane.

2. Create points at Y–25, Z0, X0 then Y0, Z–8, X0 and Y25, Z0, X0.

3. Select the points we just created.

4. Create a “3 Point Circle” (circle will have a radius of 43.063mm).

5. Terminate the circle with the points at Y+25 and Y-25.

Step #3

1. Switch to the XY plane.

2. Open the Surface Modeling palette.

3. Open the Sweep Sheet dialog.

4. Set the sweep options as
shown.
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5. Place the base curve pointer on the curve
shown and Double-click the other curve
as the drive curve.

6. Click the Do It button to create the sheet.

7. Create a cube based on the workspace stock size.

8. Slice the cube with the swept sheet.

Now you have a continuous shape which does not have quadrant intersections. Turn on Edge
Selection and you will only see the edges of the spherical ellipse at the top surface of the body.
There are no edges in themiddle of the spherical ellipse like we saw with the quadrant building
technique. Youmaymachine as desired (the sample part uses a lace cut) and you will not see
any lines in this area as you did before.

9. Save the file.

Replace History
In this tutorial we are going tomodify amodel to create a pocket. Wewill machine the pocket with
saved processes. After wemachine the part we will import a new body that represents a
redesigned pocket. Using Replace, we will recreate themodel and redo themachining.
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Part Creation

1. Open part file Swap Example.vnc.

This part file has 2 bodies — Block and Pocket. Pocket is currently not visible as it is in the Body
Bag.

Block Pocket

Saved Processes

The first thing wewill do ismake the saved processes available for use.

2. Open the Sample Parts\Solids\Required\Swap Example folder and copy the Swap Processes folder
toMyDocuments.

Placing the saved processes here will make it easy to find themwhenwe need them.

1. Right-click a Process tile and from the
menu choose Load Process List, then Set
Folder.

This will now be the default location that
processes can be loaded.

2. Navigate to theMyDocuments/ Swap Process directory and click Select Folder.
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Unstitching and Subtracting “Pocket”

Weare going to unstitch the body named “Pocket”
to close off the shape, thereby creating a core. The
interior topology is not important; it is the exterior
shape wewill be subtracting from the Block.

Opposite isometric view (Ctrl+Alt+I)

1. Turn on face selection and Right-click the bottom flat face of the pocket body.

2. Choose the Select Faces Above option.

All faces inside the pocket except the flats on top of the bosses should be selected.

3. Select the two flat tops of the bosses, as shown.
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4. Click the Unstitch button.

This results in two solids.

5. Select and Delete the smaller of the two resulting solids.

We do not need the core that was created, but we need the filled pocket body.

6. Subtract the filled pocket from the Block.

Machining the Part

Loading Processes.

1. From the process right-clickmenu, select Load Process List and select 1) Rough Pocket.prc.

This creates a tool and a process that will rough the pocket.

2. Select the faces in the pocket the sameway
we selected the faces for the unstitch and
create the toolpath.

3. Deselect the operation and Delete the process tile.
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4. From the process right-clickmenu select Load Process List and select 2) Finish Pocket.prc and
create the toolpath.

5. Render the operation.

6. Deselect the operations and place themodel in the Body Bag.

Modifying the Part

Importing the Changed Pocket

Weare now going to import amodel that is a different pocket shape.Wewill use the Replace
function to insert it where the filled Pocket bodywas used.

1. Import the file Large Cover.x_t from the Sample Parts/Solids/Tutorial Parts -
Required/SolidSurfacer/Swap & Replace folder.

Replacing the Model History

1. Aswith the smaller pocket shape, Right-click the bottom face and choose Select Faces Above
and then select the tops of the two bosses.

2. Unstitch the solid to fill it and Delete the smaller solid.

3. Extract the smaller filled pocket from the History of the Block.

4. Select the filled Large Cover solid then the smaller filled pocket. Click the Replace
button.

You will not see any changes but youmay be wondering whywe had to unstitch the larger
pocket. Shouldn’t we be able to just extract the original smaller body and replace that? The
answer is, in this case, no. Themodeler is not able tomatch up the faces of the two bodies. If we
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were using a function that was not face-dependent (translate, booleans, etc.) we could just
select the two original bodies and perform a swap or replace.

5. Right-click the Blockmodel and choose Rebuild.

Redoing the Operations

Now wewill update the operations based on the new model.

1. Select Edit > Redo All Ops and render the part.

2. Save the file; it is complete.

2D Contour
This exercise shows the 2D optimize capability of the systemwhich is for use on bodieswhich have
2D areas that we want to machine with arcs rather than several line segments. Wewill also use
another surfacing corner cleanup option in this exercise. The part we will bemaking is shown here.
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Model Creation

1. Create a new metric part with the following workspace stock size: X= 60, -X= –60; Y= 60, -Y= –
60; Z= 50, -Z= 0. and a Clearance of 65.

2. In the XZ plane wewill create a contour. For the dimension and the part print for this, see “2D
Contour” on page 167.

We do not want to create the fillets on the 13mmarc because wewill be using a tool and
intersectionmachining to create those fillets. The intersection surfacing option can only be used
on sharp corners whichmeans that you do not want to draw any fillets that you wish to create
with the tool.

Solid Model

1. Revolve the contour in the XZ plane as shown.

Make sure that you are in the XZ plane and that you are revolving about the vertical axis. The
resulting solid bodywill look like the picture shown here.

Base and Stock Bodies

Now, wewill create a stock body by offsetting the revolved body.

1. Open theOffset/Shell dialog and enter the information shown.

2. Select the revolve and apply theOffset.

3. Place the offset in the Body Bag.
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4. In the XY plane, create a cube based on the
workspace stock dimensions but change
theMax D value to 9mm.

This cube will be the base for the part. The same cuboid will be used for the stock body and the
part body.

5. Select the cube and chooseModify > Duplicate.

6. Extract the original revolve from the History list of
the offset solid.

7. Add one of the cubes to the original revolve and add the other cube to the offset.

8. Open the Properties dialog and rename the offset Stock.

The stock body should be only slightly larger.

9. In the Properties dialog select the Stock option.

The stockmodel is now blue.

Creating Operations

Tool List

With the part and stock defined, we will create themachining operationswhich are intended to
finish the part from the casting that is designated by our stock body.

1. Create the following tool list.
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# Type Total
Length Diameter Bottom

Radius
#
Flutes

Flute
Length Material

1 Ball EM 89mm 14mm n/a 4 32mm TiN Coated
2 Ball EM 63mm 8mm n/a 4 20mm TiN Coated

# 1-3, Contouring

1. Create this Contour processwith the 14mm
Ball EM (Tool #1).

2. Click the Solids tab and enter the
information shown.

3. Select themodel and create the toolpath.
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The system analyzes the selected body and identifies 2D and 2.5D areas of the solid that occur
at the various Z depths. A 2D area on a part is defined as a face whose surface normal at every
point lies in the XY plane, such as a vertical wall. A 2.5D face is defined as a face where all the
surface normals along a constant Z linemaintain the same angle with the tool axis. In this case,
the faces of the part are all 2.5D and will bemachined with arcs.

Three operationswill be created which contour the part.

To verify the toolpath the Selected OP to Screen Points will draw points at the beginning of each
toolmotion in the toolpath.

4. Choose the Solids > Tools > Selected OP to Screen Points item.

Notice that a single string of points is created along the body indicating that the toolpath is
composed of arcmoves rather than several small linemoves. If non-2D toolpath was
generated, you would see several hundred points covering the toolpath, because it is composed
of lines.

# 4, Surfacing

Now wewill create the fillets in the cavity of the part using an Intersections operation.Wewill
generate the operation from a face of the part.
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1. Create this Surfacing processwith the 8mm
Ball EM (Tool #2).

Corner Cleanup and Cut Along Intersectionwill create toolpath that runs along the edges of any
selected faces, cleaning up the intersection between the selected and neighboring faces. The
radius of the previous tool is entered (14mm) and a stepover is set.

2. Select the face shown and create the
toolpath.

The resulting toolpath and the rendered part will look like the following images.
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3. Save this file as 2D Contour.vnc.

Advanced 3D, Using Curves
• #1: N-Curve Flow

• #2: Curve Projection

#1: N-Curve Flow

1. Open the file Adv3DExtras.vnc

The geometry inWorkgroup #1 consists of four open shapes positioned on the top surface of
the core.

2. Create an Advanced 3D Machining process using the 12.5mmBall EM (Tool #1) and set the
Operation Type toN Curve Flow.
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3. Click Restore Defaults and then enter
values as shown.

4. Click the Drive Curves button to open the Select Drive Curves window.

5. Click one of the drive curves and then (Ctrl+click) the other, as shown.

6. ClickOK to close the Select Drive Curves window.

7. If necessary, deselect the Face Selection button.

8. (Ctrl+click) the solid model so as to select all faces.

9. Click theOptions tab and verify that ConnectMove Control is set to Smooth.

10. Click Entry/Exit and ensure that Entry Style and Exit Style are set to Vertical.
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11. Click the Boundary tab.

Notice under Boundary Style that the Boundary Type is set to Part Bounding Box.

12. Set the
Boundary
Mode
option to
On and
enter a
value of 0
for Extra
Offset.

13. Close the process and then click Do It to generate the operation.

Notice that the resulting toolpath hasmorphed between the drive curves. In the Surfs tab, the Cut
Along Drive Curves checkboxwas selected, causing the toolpath to run approximately parallel to
the drive curves. If the checkbox Cut Along Drive Curves were not selected, the toolpath would run
generally perpendicular to the drive curves.

Now you will change this operation to use both drive curves and trim curves.Whenworking with
both Drive Curves and Trim Curves, each curvemust be a single, open shape, and the endpoints of
each trim curvemust be at the exact same location (XYZ) of the endpoints of each drive curve.

14. Open the process, Surfs tab.

15. Click the Trim Curves button to open the Select Trim Curves window.

16. Click one of the trim curves and then (Ctrl+click) the other, as shown.
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17. ClickOK to close the Select Trim Curves window.

18. Select the body if needed.

19. Close the process and then click Redo to regenerate the operation.

Notice the resulting toolpath has extended to the trim curves.

20. Save the part.

#2: Curve Projection

1. Select Workgroup #2.

The geometry consists of two open shapes positioned on the top surface of the core.

2. Open the process, Surfs tab, and set the operation type to Curve Projection.

3. Click Restore Defaults.

Notice that Stepover is grayed out; you cannot enter a stepover value.
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4. Click the Projection Curves button to open the
Select Projection Curves window.

5. Click one of the geometry projection curves and then (Ctrl+click) the other, as shown.

6. ClickOK to close the Select Projection Curves window.

7. Select theWith Offset checkbox and enter the value 3 for Number of Offsets.

Notice that Stepover is now available.

8. Enter the value 0.125 for Stepover.

If theWith Offset checkboxwere not selected, Curve Projectionwouldmake one single pass
centered on the selected projection curves.When theWith Offset checkbox is selected, Curve
Projectionwill make a number of passes on each side of the projection curve that is equal to the
number of offsets specified, and each of the offsets will be spaced by the Stepover value. Also,
Curve Projectionwill make one single pass centered on the selected projection curve. In this case,
withNumber of Offsets equal to 3, the processwill create seven toolpaths: one on the center and
three on each side, all of which will be spaced by the Stepover value.

9. If necessary, deselect the Face Selection button.

10. (Ctrl+click) the solid model so as to select all faces, as shown above.

11. ClickOptions and verify that ConnectMove Control is set to Smooth.

12. Click Entry/Exit and ensure that Entry Style and Exit Style are set to Vertical.

13. Click the Boundary tab.

Notice under Boundary Style that the Boundary Type is set to Part Bounding Box.
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14. Set the BoundaryMode option toOn and enter a
value of 0 for Extra Offset.

15. Close the process and then click Do It to generate a new
operation.

If you zoom in, you can see that the calculation has
generated seven toolpaths for each projection curve.

16. Save the part.
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PART PRINTS

Phone
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Hot Punch
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Plumbing
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Spherical Ellipse



Part Prints

167

2D Contour
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